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Glossary 

 

Term or acronym Definition or description 

capacity expansion Increasing the placement capacity of a system by acquiring or leasing additional 
placement sites. 

cost Most commonly, the economic price of moving or placing material. However, 
environmental, social, or other costs can be used as an alternative. D2M2 does not 
mix or combine costs of different categories. 

D2M2 The original dredged material disposal management software application. It is a 
DOS program that was developed by the Hydrologic Engineering Center of the 
Corps of Engineers. The program subsequently was modified for the San Francisco 
District; it remained a DOS program with a character-based user interface. 

discount rate The interest rate used to compute the present value of cost, given the cost 
associated with moving and managing material in the system for each period of a 
multiple period analysis. If the periods considered are yearly, this is the annual 
discount rate with which annual costs are converted to the equivalent present 
value. 

dispersion ratio The ratio of volume of dredged material when wet and placed in a site during an 
analysis to the volume occupied by the material at the beginning of the next 
analysis period. The volume reduction is due to movement of the material by 
currents and other forces during the period. 

disposal site Another term for placement site. In D2M2, this may be an upland site or an in-
water site. D2M2 does not distinguish these, nor does it distinguish those for a 
transfer site to which material may be rehandled for another disposal site. 

dredging site A location from which a specified volume of material is removed in a given analysis 
period. 

end of period D2M2 considers operation of the disposal system over time, with time intervals of 
uniform, finite duration. The state of the system is considered at the start of each 
interval. Material is added to placement sites during the time interval, yielding a 
volume stored at the end of an analysis period. 

NER benefit In the 1990s, Congress added ecosystem restoration as a Corps of Engineers 
mission area. Accordingly, the Corps established national ecosystem restoration 
(NER) as an objective to be considered in planning studies, along with national 
economic development (NED). Consistent with this, D2M2 permits the user to 
define an NER benefit and use that as the basis for identification of the optimal 
allocation of material within a disposal system. Commonly, this is a non-monetary 
benefit function. 

network A system of nodes and arcs. The D2M2 program represents a disposal system as a 
network, with nodes presenting dredging and placement sites, and one-direction 
arcs representing the equipment that links the dredging and placement sites. 

OM&R Operation, maintenance, and repair. In D2M2, a cost may be incurred for OM&R 
each period; that cost is included in the total cost computed. 

optimal solution The solution that yields the minimum or maximum total cost, considering the 
entire system and the entire duration of a multiple period operation of the system 
for the user’s defined objective function. 

optimization 
objective 

This is a quantitative measure or index of the utility or desirability of an alternative 
solution to the material management problem for a defined disposal system with 
specified boundary conditions (material volumes). The measure or index, which 



4 

 

may be economic or non-economic, quantifies the utility in terms of decisions 
made, defining that utility as a mathematical function of, for example, volumes 
placed at sites or volumes moved with certain types of equipment. 

period An interval of time for the allocation analysis by D2M2. D2M2 considers operation 
of material over multiple periods, considering current and future availability of 
placement site capacity and time value of money. The periods considered are 
uniform, but may be of any relevant duration. For example, a period may be 1 
year, or it may be 1 week. It is the responsibility of the user to ensure that all data 
provided are appropriate data for the periods selected. 

reuse Beneficial use of material that has been placed and is removed from a placement 
site. 

site acquisition Addition of a site to the disposal system, either through purchase or leasing. 

site resting Forced lack of use of a placement site during a period or multiple periods. This will 
permit an upland site to dry further or material at an in-water site to disperse. 

storage Used to designate placement of material in a site or to refer to the capacity of a 
site. 

system An integrated collection of dredging sites, disposal sites, and transportation 
equipment operated in such a manner that decisions made about one site in one 
time period will have an impact on other sites in other periods. 

transfer site A placement site to which material originally place in another site may be moved. 

transportation link A connection between a dredging range and a disposal site or a connection 
between one disposal site and another (as in rehandling to a transfer site). 

unit cost The economic, environmental, or social cost per unit of volume of material moved 
or placed. 

unit disposal cost This is the cost accrued as a consequence of adding a unit volume of material to a 
placement site. The cost includes all operation costs that are a function of the 
volume deposited in the site, including mitigation costs and so on. Note that this 
cost is not limited strictly to economic cost; it may be any measure of utility. 

use-rest cycle In some disposal systems, placement sites must be “rested” after use. That is, 
additional material must not be added to sites for a specified duration, following 
use of the site. This may be required, for example, to ensure that the material 
added properly drains and consolidates before additional material is added. The 
process is referred to herein as using and resting, and the sequence is referred to 
as a use-rest cycle. 

user specified 
operation 

A material allocation scheme that is to be used instead of the optimal solution, 
considering the user's defined objective function that would be found with the LP 
algorithm that is included in D2M2. This solution must be a feasible solution to the 
material management problem. 

volume A measure of quantity of material dredged, transported, and placed in a material 
management system. Typically, volume is expressed in terms of cubic yards of 
material, but D2M2 is indifferent regarding the unit of measure of volume. 

wet-to-dry ratio The ratio of volume of dredged material when wet and placed in a site during an 
analysis to the volume of the solid material at the beginning of the next analysis 
period. The volume reduction is due to drying of the material during the period. 
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Overview of D2M2 

D2M2 is dredged-material disposal management software that was developed for the US Army Corps of 
Engineers (USACE), San Francisco District. This is a recent revision of the software that was orinally developed 
at the Hydrologic Engineering Center (HEC) of the USACE.  
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User Interface 

D2M2 provides a user-friendly graphical interface that includes following components: 

1. Main Menu Bar 
2. Main Toolbar 
3. Explorer Panel 
4. Diagram Panel 
5. Properties Panel 
6. Notes Panel 

 

 

Figure 1. User Interface 

Menus 

File Menu 

The File menu provides following options:  

 New Project. Creates a new project file. Currently opened project file will be closed prompting a 
user that it should be saved to prevent loss of data. 

 Open Project. Opens an existing project file. Currently opened project file will be closed prompting 
a user that it should be saved to prevent loss of data. 

 Save Project. Saves the current project under the same name in the same location. Saves any new 
changes over the original project file you opened. If a file is newly created, then Save will open a 
dialog allowing you to name the file and choose a save location. Otherwise, it is a simple save of 
the current information over the old, in the same place with the same name. When the project file 
is saved, the program prompts for a project description. 



7 

 

 Save Project As. Saves the current project with a new project name. D2M2 asks for a new location 
and project filename. Save Project As will always bring up the Save Project As dialog allowing you 
to change the file name and it’s save location. This allows you to keep the original file intact in its 
original location, which is useful if you would like to make a change to the network and compare 
the results. 

 Exit. Exits from the D2M2 software. 

 

Edit Menu 

Using your mouse you can select one or more items. The Edit menu provides these options:  

 Undo. Undoes the last action performed. 

 Redo. Redoes or returns the action that was undoes earlier. 

 Copy. Copies selected items into the clipboard.  

 Paste. Pastes items that was copied or cut earlier. 

 Cut. Cuts selected items into the clipboard. 

 Select All. Selects all the elements on the Diagram Panel. 

 Delete. Deletes selected items. 

View Menu 

The View menu provides these options:  

 Diagram Layout. This menu item contains two sub-elements, which allow you to change a custom 
layout for each of the two built-in – Hierarchical or Circle layouts. 

 Fullscreen. 

 Panels. This menu contains a checklist that includes four elements – application panels. Using 
the checklist, you can enable or disable these panels on the workspace. 

Run Menu 

The View menu provides these options:  

 Vary Weights. Opens a dialog which allows you to adjust the weights of optimization criteria, and 
calculate multiple solutions varying these weights within given thresholds. For example, weight of Cost 
and NER criteria. 
 

 

Figure 2. Weight Variation 
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 Exclude Routes. Opens a dialog which allows you to disable several routes, setting additional 
constraints based on the value of optimization criteria and time range in which the constraints will 
take place. 
 

 

Figure 3. Exclude Routes 

 Calculate. If all the necessary input data is filled in, you can calculate an optimal solution to the 
problem by using this function. Otherwise, the software will warn you about that certain data is 
missing. 

 Input Report.  After running D2M2, a detailed listing of the input provided on the data forms is 
available. 

 Output Report. After project calculates, the output report created. 

 

Tools Menu and Options Tab 

The View menu contains only one menu item – Options. It contains such properties as: 

 Show Site Labels. Shows or hides site labels. 

 Show Site Categories. Shows or hides site categories. 

 Site Label Color. Sets label color for all sites. 

 Show Link Labels. Shows or hides link labels. 

 Additional Link Color. Allows User to set the color of links attached to the selected site. 

 Transportation Link Color. Sets the color for all transportation links 

 Transfer Link Color. Sets the color for all transfer links 

 Link Label Color. Sets label color for all links. 

 Template Path. Allows the user to set the default path to open or save projects. 

 Confirmation Enabled. Allows the user to turn on/off delete confirmations. 
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Figure 4. D2M2 Options 

Help Menu 

The View menu provides these options:  

 User’s Guide. Shows User’s Guide document, such as you read now. 

 About. Shows About box dialog.
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Toolbar 

Toolbar provides quick access to some functions of D2M2. 

 

Figure 5. D2M2 Toolbar 

1. New Project 

2. Open Project 

3. Save Project 

4. Save Project As 

5. Undo Action 

6. Redo Action 

7. Cut 

8. Copy 

9. Paste 

10. Delete 

11. Select All 

12. Calculate 

 

All this quick actions provide the same function as the same items in menu bar. You can place the toolbar 

in a convenient place for you. To do this, press the left mouse button on the left side of toolbar, and drag 

to the desired location and then release the mouse button.
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Workspace 

Explorer Panel 

Explorer Panel is used to navigate through all elements of the project. 

 

Figure 6. D2M2: Explorer Panel 

There is a special toolbar on the top of the Explorer Panel that allows you to add the following items into 

the project: 

 
Equipment 

 
Dredge Site Category 

 
Equipment Category 

 
Disposal Site Category 

 
Link Category 

 
Transfer Site Category 

To add the required element, just click the appropriate icon. 

The root element of the Explorer Panel is the opened Project, which includes following categories of 
items which are represented by branches of the tree: 

 Dredge Sites 

 Transfer Sites 
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 Disposal Sites 

 Links 

 Equipment 

 Dredge Categories 

 Transfer Categories 

 Disposal Categories 

 Link Categories 

 Equipment Categories 

Using the Explorer Panel you can dig into any category looking for certain project items. 

Diagram Panel 

Diagram Panel is a center element of a graphical user interface. It consists of a toolbar and a 
network diagram. The toolbar allows user to add sites into the network diagram via drag’n’drop. Also user can 
adjust the network diagram scale using the Toolbar. And the last button allows user to link all sites matching to 
each other by category automatically. 

 

Figure 7. D2M2: Diagram Panel 

The toolbar on the top of the Diagram Panel contains the tool icons used to draw the network diagram:  

 
Dredge Site tool. Drag this item to network area and drop it to add 
dredge site to the network diagram.  

 
Disposal Site tool. Drag this item to network area and drop it to add 
disposal site to the network diagram. 

 
Transfer Site tool. Drag this item to network area and drop it to add 
transfer site to the network diagram. 
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Scale tool. Use this combo-box to zoom in and out of the network 
diagram. 

 

  

 
Auto-link tool. Automatically links all the sites that can be 
connected according to the criteria: equipment or distance. Optionally, 
links not meeting constraints can be removed. 

  

 

  

Figure 8. Linking Strategy 

 

Adding sites 

You need to add dredge and disposal sites to a network diagram with specific data before you calculate 
your data. 

1. Click left mouse button on the appropriate icon on the toolbar (dredge, transfer or disposal site). 
2. Drag the icon to the drawing area. 
3. Release the left mouse button 

When a site is added to the drawing area, it is given a default name such as Dredge Site #1. 
 

Linking sites 

D2M2’s linking rules are as follows:  

 A dredge site can be linked to one or more disposal or transfer sites (to simulate transfer of material 
from the dredge site to the disposal or transfer sites).  

 A dredge site may have multiple links to a single disposal or transfer site (to represent multiple 
transportation categories). 

 Each transfer site may be linked to up to 20 disposal sites (to simulate transfer of material between a 
transfer site and disposal site). Disposal sites may not be linked to any other disposal site. 

 Dredge sites may not be linked to any other dredge sites. 

 Arrows representing links show the direction of material flow between sites. 
 
To link one site to another: 

1. Click left mouse button on the site. 
2. Drag the arrow to the link you want to connect to. 
3. Release the button. 
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Zoom 

Use Scale tool to increase or decrease the magnification level of the network diagram. 
1. Click on the arrow on the right side of Scale tool 
2. Select the scale you need to use 

 
Also you can change scale using mouse: 

1. Hold down Ctrl-key 
2. Change scale using mouse wheel 

 
When the entire diagram area is outside the visible region of the Diagram Panel you can use scrollbars to 

navigate the diagram. 
 

Table Panel 

Table Panel is used to navigate through all elements of the selected item group and to compare item 
properties. 

 

 

Figure 9. D2M2: Table Panel 
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Properties Panel 

Properties Panel is used to display the properties of the items of the project. When any element (or group 
of elements) in the Explorer Panel or on the Diagram Panel is selected, the Properties Panel displays the 
properties of the selected element (or a description of the elements). Using this panel you can adjust different 
properties of any elements in project. 

 

Figure 10. D2M2: Properties Panel 

 

On the top of Properties panel you can see the following buttons: 

  Collapse all categories in Properties panel. 

 Expand all categories in Properties panel. 

Each Properties panel consists of a set of categories related to the selected object. You can collapse or 
expand the parameters of categories by pressing on the category name. 
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Notes Panel 

Notes Panel is used to display the notes for project items. When an element in the Explorer Panel or on 
the Diagram Panel is selected, the Notes Panel displays the notes for the selected item.  

 

Figure 11. D2M2: Notes Panel 

When you add your comment just click on the any object and your note will be saved in to the model. 
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Project input 

D2M2 input consists of a description of each dredging project, each disposal site, each type of 
transportation equipment that may link dredging projects and disposal sites, any user-specified operation 
instructions, some basic information for economic analysis and model setup, a description of the optimization 
objectives, system-wide constraints, and equipment and disposal categories.  

This information is entered by changing the properties of any element in Project. All the properties are 
available from the Properties Panel by clicking a necessary element in the Diagram Panel or the Explorer Panel. 

Project Properties 

To change the basic properties of your project you have to select the Project element in the Explorer panel 
(the root of the explorer tree). To change the properties enter necessary data in to the following fields. 

 

Figure 12. Project Properties 

The Project properties contains following elements: 

 General 
o Type. Default field that shows what kind of object is selected now.  
o Name. Enter the name of the project.  
o User Name. Enter your initials. 
o Discount Rate. Enter the effective discount rate per period, expressed as a 

percentage. D2M2 computes the present value of all benefits and costs with this 

rate. Valid values range from 0 to 1.  

o Number of iterations.  
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o System of Units. Select either English or SI (modern metric) units of measurement. For 
English units, distances are specified in miles and volumes are specified in cubic yards. For 
SI units distances are in kilometers and volumes in cubic meters. 

o Map Units.  Select the unit used in longitude, latitude fields. The same units must be used 
in the GIS-projects, related with the current model project. 

 Periods 
o Period increment. Select the increment time of periods (Sequential Number, Annual, 

Semi-Annual, Ter-Annual, Quarterly, Bi-Monthly, Monthly, Semi-Monthly, Bi-Weekly, 
Weekly) 

o Number of periods. Enter the number of periods for which D2M2 is to analyze system 
operation. 

 First Period 
o Year. Enter the year from which you need to start your computations. 
o Increment.  

 Optimization.  

o Optimization Objective. Select the option that allows you to elect minimize or maximize 
the optimization objective. 

o Optimization Criteria. Edit the table containing the standard criteria (Cost and NER), and if 
necessary add a new criteria. 

 Constraints 
o User Specified Operations. Enter specific operating instructions. 
o System Wide Constraints. Enter system-wide equipment, links and disposal constraints. 

 Background 
o Background Image. Set the graph background image. 

 
 

Sites properties 

Dredge-site properties 

Dredge sites must be added to the network diagram before information may be added here. 

 

Figure 33. Dredge Site Properties 

Dredge Site properties contain following elements: 

 General 
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o Type. Default field that shows what kind of object is selected now.  
o Name. Enter the name of the Dredge Site. 
o Site Category. Select site category (to add site categories you can use Explorer Panel). 
o Equipment Category. Select a category of equipment that can be used with this site (to 

add equipment categories you can use Explorer Panel).  

 Fixed-Cost Factors 
o Fixed-Cost Factors. Fixed-Cost Factors linked with equipment fixed cost.   

 Location 
o Latitude. Enter the latitude in degrees.  
o Longitude. Enter the longitude in degrees. 

 Volume 
o Volume. Enter the wet volumes that are to be dredged at this project each period. A 

volume must be specified for each period of analysis. 

Disposal and Transfer site properties 

Disposal and transfer sites must be added to the network diagram before information may be added here. 
Transfer sites are special cases of disposal sites and use the same properties. 

 

Figure 44. Disposal and Transfer Sites Properties 

 
Disposal or Transfer Site properties contain following elements: 
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Dredge Site properties contain following elements: 

 General 
o Type. Default field that shows what kind of object is selected now.  
o Name. Enter the name of the Site. 
o Site Category. Select site category (to add site categories you can use Explorer Panel). 
o Equipment Category. Select a category of equipment that can be used with this site (to 

add equipment categories you can use Explorer Panel).  

 Fixed-Cost Factors 
o Fixed-Cost Factors. Fixed-Cost Factors linked with equipment fixed cost.   

 Location 
o Latitude. Enter the latitude in degrees.  
o Longitude.  Enter the longitude in degrees. 

 Storage 
o Initial Storage. Enter the volume of material stored in this disposal or transfer site at the 

beginning of the first period. This volume must not exceed the capacity of the site. 
o Wet-to-dry Ratio. Enter the average ratio of volume of wet material deposited in this site 

to volume of material after drying within 1 time step. 
o Maximum Addition per Period.  Enter the maximum allowable addition of unconsolidated 

material to this disposal site per period.  
o OM&R per Period.  Enter any fixed annual operation, maintenance, and replacement 

(OM&R) cost or other utility for this disposal or transfer site. This cost is incurred at the 
end of each period the site is available, regardless of the volume of material stored in the 
site. 

 Unit Cost or Benefit 
o Unit Disposal Cost. Enter the cost per unit volume of wet material added to this disposal 

or transfer site. 
o Reuse Unit Benefit. Enter the return for reuse of material from this site. For objective 

function components other than cost, this value represents the user-specified metric 
instead of cost. 

o NER Benefit. Enter the NER benefit per unit volume of wet material added to this disposal 
or transfer site. This benefit is multiplied by the weighting factor entered for the NER 
benefit component of the optimization objective. 

 Site Acquisition Data 
o Acquisition Cost. Enter the cost or other utility of making this disposal or transfer site 

available for use. This cost includes the cost of facilities, real estate, and mitigation of 
adverse environmental or cultural impacts. 

o Earliest Acquisition Period. Enter the actual or earliest-possible period of site acquisition. 
o Latest Acquisition Period. Enter an integer to identify the last period in which acquisition 

of this site will be permitted. 
o Number of Periods before Resting. Enter a number to specify the number of periods this 

site is available prior to resting in a use-rest cycle. This site will be alternately included for 
the specified number of periods before resting and omitted for the specified number of 
resting periods. 

o Number of Resting Periods. Enter a number to specify the number of periods this site is 
rested. This site will be alternately included for the specified number of periods before 
resting and omitted for the specified number of resting periods. 

 Lease Data 
o End of Lease Period. Enter the period in which the lease terminates. Depending on the 

expansion code, the site will either be unavailable after this period, or the lease will be 
renegotiated in this period. 

o Lease Renegotiation. Enter the lease renegotiation cost or other utility. For objective 
functions other than cost, this value represents the user-specified metric instead of cost. 

 Reuse Data 
o First Period Possible. Enter the first period in which reuse is possible. 
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o Maximum Rate. Enter the maximum volume that may be removed per period for reuse. 
This value must not exceed the site capacity. 

 Topography Relations 
o Topography Relations. Fill the additional table with the volumes of data for the capacity, 

surface elevation, and surface area relationship.  
 

Link Properties 

In the D2M2 there are two types of links: 

1. Transportation link. Link between Dredge and Transfer or Disposal Sites. 
2. Transfer link. Link between Transfer and Disposal sites.   

 

 

Figure 55. Transportation Link Properties 

 

Figure 66. Transfer Link Properties 

 
Transfer (and also Transportation) Links properties contain following elements: 

 General 
o Type. Default field that shows what kind of object is selected now.  
o Name. Enter the name of the Dredge Site. 
o Category. Select link category (to add link categories you can use Explorer Panel). 
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o Distance. Enter distance between the sites (link distance). 
o Maximum Volume. Enter maximum volume that may be moved between the sites in any 

single period with this transportation equipment. 
o Earliest Possible Period (only for Transfer Links). Select the earliest possible transfer 

period. 

 Linked Sites 
o Source (not editable). Shows source site of the link.  
o Target (not editable). Shows target site of the link. 

 Equipment 
o Equipment. Select the transportation equipment with which the transfer of the material 

occurs between the sites (to add transportation equipment you can use Explorer Panel).  
 

Equipment 

Transfer between sites is happening with using of different equipment (pipelines, ships, etc.), so each link 
is associated with specific transportation equipment. To add the transportation equipment use Explorer Panel. 

 

Figure 77. Transportation Equipment Properties 

Transportation Equipment properties contain following elements: 

 General 
o Type. Default field that shows what kind of object is selected now.  
o Name. Enter the name of the Transportation Equipment. 
o Category. Select equipment category (to add link categories you can use Explorer Panel). 

 Average Fixed Cost 
o Average Fixed Cost. Edit the table that contains Average Fixed Cost relationship. (Addition 

of the fixed cost can significantly increase calculation time) 
 

 Distance Vs Cost 
o Distance Vs Cost. Edit the table that contains Distance v. cost per unit volume relationship. 
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Categories 

For convenience in reporting or for constraining system operation, each equipment type may be assigned 
to a user-specified category. To do so, the user may select a previously defined category here. In the D2M2 
project there are 3 types of categories: 

 Equipment category 

 Link category 

 Site category 

Categories are used for user convenience only and have no practical information for model.  For example 
Equipment category have only one data field – Name of category. Also for more convenient display on a 
network diagram, you can choose different colors for different categories of links. Finally, for more convenient 
display of various categories of sites you can change the special identifier to be displayed directly on the site 
icon. 

 

 

Figure 88. Categories Properties 
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Project Execution 

Once the necessary data have been entered, D2M2 can find the minimum-cost management strategy. To 
run D2M2, select Calculate from the Run menu, or click the Calculate icon in the toolbar on the Diagram Panel. 
The time required for the computations depends on the size of the disposal system being modeled. After all 
the calculations will be performed D2M2 will automatically show Output Report. 

Project Reports 

D2M2 contains two types of reports - reports of the input data and reports with the output results. These 
reports are available using the Run menu. 

Input Report 

Input Report can be viewed at any time. It is divided into three parts: 

 Basic Project Data 

 Disposal/Transfer Site Report 

 Dredge Site Report 

 

Figure 99. D2M2 Input Report 
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Figure 20. D2M2 Input Report 

To view the Input Report click the Input Report from the Run menu. To print the report, select 

Print from the Input Report toolbar.  

Select save icon to save the report to another file format, such as *.doc, *.pdf, *.html, etc. 
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Output Report 

After D2M2 calculates, the Output Report is created. 

To view the Output Report click the Output Report from the Run menu. To print the report, 

select Print from the Input Report toolbar.  

Select save icon to save the report to another file format, such as *.doc, *.pdf, *.html, etc. 

 

 

Figure 21. Output Report 
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Figure 22. Output Report 
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Integration with DSS- and GIS-modules 


